
Palaeontologia Electronica 
http://palaeo-electronica.org
Idealized landmark-based geometric reconstructions 
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a case study of an early tetrapod vertebra
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ABSTRACT

Three-dimensional (3D) digital models of bone morphology are used frequently in
paleontology and anthropology. Because fossils are often fragmentary or distorted, it
often becomes necessary, for either aesthetic or practical reasons, to create an ideal-
ized version of digital skeletons. We propose a method for building landmark-based
geometric reconstructions of fossil bones in 3D graphics software using CT or laser
scan data as a template. This method does not require specialized software or artistic
expertise. It allows control of local mesh density, specification of important landmarks
and major planes, elimination of large holes and extraneous structures, and interactive
adjustment of 3D shape by moving a small number of vertices to correct minor tapho-
nomic deformation. The result is a simple, illustrative, and accurate model that can be
used for diverse analytical and visualization applications, including reconstructions of
incomplete fossils, watertight models for mass and center of mass approximation, base
meshes for thin plate spline warping, and intermediates in an incomplete series via
“morphing.” To demonstrate the method, we applied it to reconstruct a dorsal vertebra
from the basal tetrapod Acanthostega gunnari. We validated our methodology with lin-
ear and geometric morphometric comparisons of our reconstructions both against the
original scan data and between three different operators. Based upon four linear mea-
surements, the average deviation of the models from the original was minimal, showing
that the method preserves the proportions of the original fossil. We found no statisti-
cally significant shape difference between models built by different operators, demon-
strating that the method is repeatable.
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INTRODUCTION

Background

Three-dimensional digital models of bone
morphology derived from laser surface scans,
computed tomography (CT), or mechanical digitiz-
ing are used frequently in paleontology and anthro-
pology. Virtual fossils can be manipulated using
computer programs in order to, for example, cor-
rect taphonomic distortion, study basic anatomy for
its own sake or for phylogenetic analysis, examine
differences in bone shape between individuals or
species using morphometrics, analyze biomechan-
ical parameters, and produce interesting and infor-
mative scientific visualizations (reviewed in
Bookstein, 1997a; Zollikofer et al., 1998; Lewin,
2002; Alexander, 2006; Sutton, 2008; Gunz et al.,
2009). 

In fossil reconstruction, digital models permit
manipulations that would be impossible with speci-
mens or casts, such as “digital dissection” of inac-
cessible areas without risking damage to the
specimen, mirroring forms and combining parts of
different specimens, virtually articulating struc-
tures that are too massive to move in reality or
embedded in matrix, and visualizing internal struc-
tures using transparency and virtual endocasts
(e.g., Witmer et al., 2008; Zollikofer and Ponce de
León, 2005). For example, Zollikofer et al. (2005)
used digital retrodeformation to restore the skull of
Sahelanthropus tchadensis and help diagnose it as
a fossil hominid rather than an ape. 

In the field of biomechanics, digital skeletons
of extinct animals increasingly are being used in
novel ways, including estimating joint range of
motion and posture (e.g., Stevens and Parrish,
1999; Mallison, 2010b, c), as a framework for soft-
tissue reconstructions to estimate mass parame-
ters (e.g., Henderson, 1999; Motani, 2001;
Hutchinson et al., 2007; Bates et al., 2009, 2010;
Mallison, 2010a), and in simulation software to
derive muscle moment arms  and energetic costs
of locomotion (e.g., Hutchinson et al., 2005;
Nagano et al., 2005; Sellers and Manning, 2007;
Sellers et al., 2009, 2010; Bates et al., 2010). Digi-
tal skeletons also can be used to calculate bone
stresses and strains using finite element analysis

(FEA) (e.g., Rayfield et al., 2001; Moreno et al.,
2007; Snively and Russell, 2002; Strait et al., 2009;
Wroe et al., 2010). Finally, digital models are
invaluable in the arena of visualization to accom-
pany photographs in manuscripts and web sites,
plan or augment physical displays in museums
(and even create physical models through rapid
prototyping), and share data between researchers
in different parts of the world (Mallison et al., 2009).

For some of these applications, and especially
when using virtual skeletons for visualization, it
often becomes necessary to create an idealized
version of fossil morphology. This requirement can
arise when using computer software designed to
work with medical imaging data (such as some bio-
mechanics software) that requires continuous,
closed surface geometry, for visualization applica-
tions when smoothness and low computational
cost are desirable, or for facilitating correction of
distortion (Stevens, 2002; Hutchinson et al., 2005;
Sellers et al., 2009). While generally readily avail-
able for extant species, high quality scan data are
less available for extinct animals because fossils
often are incomplete or broken and may show up
poorly on CT scans. Large and/or mounted speci-
mens that are unsuitable for CT scanning may be
captured using a laser surface scanner or a
mechanical digitizer, but this method often yields
meshes with large gaps where the scanner beam
cannot reach, imperfectly aligned surfaces, and
extraneous elements such as mounting rods.

With these challenges in mind, we propose a
method to build idealized geometric models in 3D
graphics software from which biomechanical, volu-
metric, morphometric, and other data can be
extracted in the absence of a well-preserved, com-
plete specimen or comprehensive scan data. Our
goal was to find a happy medium between using
collections of geometric primitives (such as cubes
and cylinders) as proxies for bones and the more
time consuming and computationally intensive
approaches that are the standard in paleoanthro-
pology (see below), some of which are not applica-
ble to specimens with unique morphologies. Here
we use the triangulated mesh derived from a CT or
laser scan as a template to model a landmark-
based geometric reconstruction of a tetrapod verte-
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bra. Our method is reasonably simple and repeat-
able because the placement of vertices is dictated
by the location of biological and geometric land-
marks and constrained to the surface of the tem-
plate mesh. We borrow from computer graphics
techniques by planning the model’s geometry
around biologically meaningful structures such as
body axes and articulations.

Related Work - 3D Virtual Fossil 
Reconstruction

Driven by the challenges inherent in working
with fossils, very sophisticated methods of fossil
reconstruction have been developed over the
years. Modern computer-based 3D methods using
CT and laser scan data fall into two general cate-
gories. The first is “jigsaw puzzle” reconstruction
and/or hole-filling to correct brittle deformation
(e.g., Ponce de León and Zollikofer, 1999; Zol-
likofer et al., 2005). The second is warping to cor-
rect plastic deformation using bilateral symmetry or
knowledge of the direction of deformation (e.g.,
Bookstein, 1989; Hamada et al., 1991; Motani,
1997; Ponce de León and Zollikofer, 1999; Ogihara
et al., 2006; Angielczyk and Sheets, 2007; Gunz et
al., 2009). In the more difficult cases, researchers
may attempt to extrapolate missing morphological
information based upon homology (“statistical
reconstruction”; Gunz et al., 2009) or geometry
(“geometric reconstruction”; Zollikofer and Ponce
de León, 2005). Extrapolation is useful for such
tasks as estimating the volume of non-watertight
“leaky” structures and visualizing specimens for
display or comparison. While data derived from
extrapolation are not guaranteed to be accurate,
one can obtain a good estimate of the range of
possible values by repeating the process using dif-
ferent methods and assumptions (Zollikofer and
Ponce de León, 2005). Of course, one always must
be explicit about the methods used and which data
have been extrapolated. Geometry- and homology-
based extrapolation methods both have strengths
and weaknesses and are appropriate in different
scenarios (Zollikofer and Ponce de León, 2005).

Homology-based extrapolation takes advan-
tage of biologically homologous landmarks to com-
pare a complete reference specimen with the
incomplete target specimen. A thin-plate spline
(TPS) function based upon the difference between
landmark configurations of the reference and target
specimens defines a “deformation space.” The
vectors from the deformation space are then used
to warp the reference specimen to match the land-
mark configuration of the target (Bookstein,

1997b). Although this approach yields highly
detailed, realistic-looking results, it is important to
realize that it is primarily a visualization tool (Book-
stein, 1997a). The TPS function interpolates defor-
mations geometrically between landmark points,
and therefore it does not confer definite biological
information beyond (or between) the landmark
data. Because of this, it is important to choose a
reference specimen that represents the plesiomor-
phic condition to avoid biasing the results towards
the derived morphology of the reference specimen
(Gunz et al., 2009). To avoid this problem, some
researchers have used statistical or geometric
morphometrics to analyze multiple related species
and produce a “consensus” landmark configuration
(Wiley et al., 2005). Others have relied on an ideal-
ized, artist-generated template (Allen et al., 2003;
Souter et. al, 2010). 

Regardless of the method of template genera-
tion employed, homology-based extrapolation
requires one or more complete specimens, which
share a set of biologically homologous landmarks
with the target specimen (Mitteroeker and Gunz,
2009). However, it is rare in paleontology to have a
large number of complete specimens within a spe-
cies. Geometry-based extrapolation circumvents
the problem of reference specimens by relying
instead upon the preserved geometry of the origi-
nal specimen. A deformable template with the
desired topology, often a spline surface, is created
and then warped using the energy-minimum princi-
ple to match the specimen’s configuration with min-
imum internal energy (conceptually similar to
shrink-wrapping) (Zollikofer and Ponce de León,
2005). With respect to re-creating the original anat-
omy, this approach is probably less accurate than
homology-based extrapolation; however, it avoids
species bias and is a considerably simpler opera-
tion.

Rather than using splines to alter polygonal
geometry, other researchers build spline contours
from their data in the initial acquisition phase by
using mechanical digitizing rather than CT or laser
scanning (e.g., Hutchinson et al., 2005, 2007; Mall-
ison et al., 2009). In this procedure, a series of con-
tour lines are marked upon the physical specimen
and the digitizing apparatus is moved along the
bone’s surface, collecting 3D spatial coordinate
points. The points are connected with splines to
make contour lines, and the contour lines are lofted
to create a non-uniform rational B-spline (NURBS)
surface. Alternatively, digitized points can be saved
as a point cloud, and a NURBS surface can be
generated automatically using 3D software such as
3
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Rhinoceros (www.Rhino3d.com) or Geomagic
(www.Geomagic.com). The advantages of
mechanical digitizing over laser and CT scanning
are cost and file size; additionally, it works well for
fossils that are too large for CT scanning, and it
can make reconstruction simpler due to the proper-
ties of NURBS surfaces (Mallison et al., 2009).

Our method of landmark-based geometric
modeling addresses some of the problems of fossil
reconstruction by combining elements of several
approaches. Like Ponce de León and Zollikofer
(1999) and others, we use a 3D surface derived
from a CT scan of a specimen to place geometric
and biological landmarks (Figure 1), and like Allen
et al. (2003) and Souter et al. (2010), we construct
our model using computer graphics-inspired tech-
niques to maximize accuracy of shape while mini-
mizing vertices. Similar to geometric extrapolation,
we use a type of spline function to interpolate
between landmark points without reference to a
homologous specimen, and similar to mechanical
digitizing, we extract a subset of surface points to
build a simplified, idealized 3D representation of
the specimen using NURBS curves. 

Polygonal Surfaces, Splines, NURBS, 
and Landmarks

A major component of our reconstruction
method is the conversion of bone geometry from a
polygonal surface (stereolithography or STL file
format) to a spline surface using geometric land-
marks. Commonly used to represent 3D digital sur-

faces including CT and laser scan data, STL files
consist of a set of contiguous faces, each usually
defined by three vertices and a normal vector that
differentiates between the inner and outer surface.
Polygonal surfaces such as STLs are discontinu-
ous; that is, their tangents change sharply at each
edge. While STL files are useful because they are
relatively easy to extract from 2D slices (CT scans)
and point clouds (laser scans and mechanical digi-
tizers) and are widely supported by modeling and
analysis programs, sometimes it is desirable to
construct models using continuous (spline) sur-
faces. Splines are useful in modeling organic
shapes because they smoothly interpolate
between points, requiring fewer control vertices to
describe curving surfaces. In the biological sci-
ences, spline surfaces are commonly used in pale-
ontology to construct deformable templates (e.g.,
Zollikofer and Ponce de Leon, 2005) in geometric
morphometrics to describe shape variation (Book-
stein, 1989) and visualize extreme morphologies
(e.g., Pierce et al., 2008; Pierce et al., 2009), and
in FEA to transform existing FE models to match
new morphologies (e.g., Stayton, 2009).

Splines are curves or surfaces defined mathe-
matically by piecewise polynomial functions. They
interpolate between operator-defined points or
“knots” to describe a curve that minimizes bending
energy between knots (Bookstein, 1989). NURBS
are a category of splines used in scientific visual-
ization, industrial design, and, less frequently, pale-
ontology. For example, Strait et al. (2009)
constructed a solid structure of a skull belonging to
Australopithecus africanus using NURBS in a 3D
modeling program for the purpose of finite element
analysis (FEA), and NURBS surfaces have been
used, for example, to reconstruct idealized skeletal
elements for biomechanical analysis of Tyranno-
saurus rex (Hutchinson et al., 2005) and to approx-
imate soft tissue volume in order to estimate center
of mass for T. rex and the sauropodomorph dino-
saur Plateosaurus engelhardti (Hutchinson et al.,
2007; Mallison, 2010a).

Geometrically, “landmarks” or “landmark
points” are local extrema that correspond between
objects. “Biologically homologous landmarks” are a
subset of landmark points for which “objectively
meaningful and reproducible counterparts” exist
between all forms (Bookstein, 1989). Not all land-
marks are biologically homologous, and it is neces-
sary to use only biologically homologous
landmarks when comparing specimens of different
species. However, when simply comparing
between shapes, any identifiable geometric land-
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FIGURE 1. Locations of 18 biological and geometric
landmarks on a neural spine (NS) of Acanthostega.
Landmarks on intercentrum (IC) and pleurocentrum
(PC) not shown. The locations of these points on the
template specimen determine the placement of vertices
in the final reconstruction. Note that the majority of the
chosen landmarks lie along the edges of four local
planes: anterior, posterior, medial, and lateral; this will
simplify model creation (next section).
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marks can be used. In this paper, the unqualified
term “landmarks” refers to geometric landmarks.

MATERIALS AND METHODS

Purpose of Study

To demonstrate the method of landmark-
based geometric reconstruction, we applied it to
reconstruct a dorsal vertebra (neural arch, inter-
centrum, and pleurocentra) from the basal tetrapod
Acanthostega gunnari, a Devonian tetrapod with a
morphology intermediate between aquatic lobe-
finned fishes and fully terrestrial early tetrapods.
Acanthostega is widely considered to be a critical
sister taxon of modern terrestrial vertebrates (Ahl-
berg and Milner, 1994; Coates, 1996; Clack, 2002;
Coates et al., 2002; Carroll, 2009). The locomotor
behavior of Acanthostega is therefore of utmost
interest to evolutionary biologists for reconstructing
the evolution of terrestrial locomotion in Tetrapoda
(currently under study by the authors). However,
fossils of the animal are scarce, and those avail-
able have low matrix-bone contrast, making them
difficult to translate into high-fidelity 3D models. We
validated our methodology with geometric morpho-
metric comparisons of our reconstructions both
against the original mesh derived from CT scan
data to test their accuracy and between operators
to evaluate repeatability. 

CT Datasets

A portion of the Acanthostega specimen con-
taining neural arches, intercentra, and pleurocentra
(Geological Museum, University of Copenhagen:
MGUH f.n. 1227; Figure 2) was micro-CT scanned
with a Metris X-Tek HMX ST 225 CT scanner (slice
increment: 0.169, pixel size: 0.085 mm).

Segmentation of CT data

The CT dataset was imported into Mimics
(Materialise Inc. (www.materialise.com\mimics);
Leeuwen, Belgium), a commercial image process-
ing program for segmenting CT and MRI data and
constructing triangulated 3D surface meshes.
Because it did not contain sufficient contrast for
automatic segmentation, the Acanthostega dataset
was processed by hand: on each CT slice, the area
representing an individual bone was selected using
the Lasso tool and added to a mask (Mimics
image). The choice of vertebra was dictated by
preservation: we exported the most complete and
apparently least distorted vertebra, thought to be
the 21st dorsal. Acanthostega has multipartite ver-
tebrae, each consisting of a neural spine, intercen-

trum, and paired pleurocentra (Coates, 1996). Only
the left half of the vertebra is preserved in this
specimen, and the medial surface is not distin-
guishable. The pleurocentra were not preserved for
the 21st dorsal vertebra and were segmented from
a different vertebra in the same series (19th dor-
sal). Each element was volume-rendered using the
“Medium” setting (Figure 3), and its surface was
exported as a separate STL file. A smoothing filter
(Laplacian smooth, 1 iteration) was applied in the
free mesh processing software MeshLab
(www.meshlab.sourceforge.net) to simplify visual-
ization. Because of the large number of vertices in
the STL file (over 130,000), this operation had a
negligible effect upon the geometry.

Creating NURBS Models in Autodesk Maya

STL files were imported into Autodesk Maya,
a 3D animation and modeling program for com-
puter graphics (Autodesk Inc. (www.autodesk.com/
Maya); trial version free to download). When build-
ing an idealized model of a bilaterally symmetrical
form, such as a vertebra, it is generally preferable
to reconstruct only one half and then join it with its
mirror image, as was done in this case. Had both

FIGURE 2. Original specimen of Acanthostega gunnari
(MGUH f.n. 1227).  Arrow points to neural arch of the
vertebra that was used for the reconstruction.
5
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halves of the vertebra been preserved, we would
have divided the mesh along its mid-sagittal plane
and removed one half before proceeding (see
Appendix for procedures in Maya).

Mapping landmarks onto the 3D surface. A UV
map was created for the mesh to allow “painting”
on its surface with the 3D Paint tool. Contours
delineating major planes were marked in blue
(anterior, posterior, lateral, and medial; the superior
edge of the neural spine and the diapophysis [rib
articulation] of the transverse process are modeled

separately). Major biological and geometric land-
marks, located at the intersections of major planes
and the boundaries of important biological struc-
tures, were marked in red. Perpendicular contour
lines were added (violet) connecting corresponding
landmarks on opposite edges of the planes (e.g.,
the anterior superior tip of neural spine was con-
nected to the posterior superior tip of neural spine).
Subsidiary contours were added (green) roughly
parallel to the plane contours to define the medial
and lateral surfaces. The number of subsidiary
contour lines is a matter of judgment; each addi-
tional contour that is added will increase both the
complexity and the fidelity of the model. The result
was a generally evenly spaced grid that became
more closely spaced in areas of special interest
and/or geometric complexity (Figure 4).

Creating contour curves and NURBS surfaces.
NURBS terminology in Maya is similar to that used
in the introduction (“Polygonal surfaces, splines,
NURBS, and landmarks”). When creating a curve
in Maya, knots are referred to as “Edit points” and
the segment between points as a “span.” “Degree
setting” refers to the degree of the polynomials that
describe a curve or surface.

The mesh was made “Live” in order to con-
strain the knots of the NURBS curves to the mesh
surface. This step ensured that the points used to
create the contours would exactly correspond to
data points on the template mesh. NURBS curves
were created following the blue lines (major plane
junctions) and green lines (medial and lateral sur-

FIGURE 3. Vertebral elements segmented in Mimics
from a micro-CT scan of MGUH1227. Neural spine
(green), intercentrum (blue), and pleurocentrum (red)
volume-rendered using the “Medium” setting (134,369
vertices). Only the left half of the vertebra is preserved,
and the pleurocentrum has been taken from an adja-
cent vertebra.

FIGURE 4. Mapping landmarks onto the scan data and planning curve placement on a neural spine of Acanthostega.
4.1, edges of major planes (blue lines); 4.2, landmarks (red dots); 4.3, perpendicular contour lines (violet); 4.4, subsid-
iary contour lines (green). Major plane contours define the anterior, posterior, medial, and lateral surfaces. Landmark
points are located at the boundaries of major planes and structures such as neural spines, zygapophyses, and trans-
verse processes. Perpendicular contours passing through corresponding landmark points create a grid on the surface
of the template, and subsidiary contours describe the geometry of the lateral and medial surfaces of the neural arch.
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faces) with an edit point at each intersection with
the purple lines (perpendicular contours) (Figures
5, 6). 

The curves were “lofted,” or joined by interpolated
NURBS surfaces, to create a continuous NURBS
shape (Figures 7, 8). The purpose of the painted
grid was to create a set of curves that was optimal
for lofting. It ensured that each curve was created
using similarly spaced knots and the same number
of spans, improving the appearance of the NURBS
surface. Additionally, since curves were created
following a set of fairly evenly spaced, non-inter-
secting lines, it was easy for the program to create
a smooth surface in the perpendicular direction.

Adjustments and extrapolation of missing sur-
faces. This point in the reconstruction process is
the ideal one to adjust the model to better fit the
data or to correct deformation. This is because the
NURBS surface is controlled by the NURBS curves
and is updated dynamically as their shapes are
changed. The NURBS surface was selected and
moved to one side so that the curves could be
selected more easily. Then, using the surface to
visualize the results, the curves were adjusted by
moving the knots. First, areas on the model that did
not match the template mesh well were identified
and improved by sliding knots along the surface of
the template mesh (Figure 9). Next, knots were
adjusted by eye (without snapping to the template

FIGURE 5. Creating contour curves. Using the Edit
points curve tool, knots were placed along the contour
lines (blue and green) using a setting that constrained
them to the surface of the template mesh at the inter-
sections with perpendicular lines (purple). Note that
each curve has the same number of knots. 

FIGURE 6. Video showing process of creating contour
curves. (PE note: videos available online at palaeo-elec-
tronica.org.

FIGURE 7. Lofting curves to create a NURBS surface.
Contour curves were selected sequentially moving
around the circumference of the template mesh. The
curves were lofted to create the NURBS surface repre-
senting the left half of a neural spine of Acanthostega
(80 knots). 

FIGURE 8. Video showing process of lofting curves to
create a NURBS surface. 
7
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mesh) to correct presumed scanning errors and
taphonomic deformation. In this case, the medial
surface of the intercentrum and pleurocentrum, not
distinguishable from the scan, were altered to
match Coates’ (1996) two-dimensional reconstruc-
tion (Figure 10).

Closing open edges. After all adjustments had
been made, the open ends of the surfaces were
either closed with facets (e.g., the diapophysis on
the transverse process of the neural arch) or left
open to be joined with bilaterally symmetrical
halves after mirroring (e.g., the inferior edge of the
left half of the intercentrum) (Figures 11, 12).

Mirroring and attaching. After all elements had
been modeled, they were grouped and mirrored.
The two halves of the intercentrum were attached
at the mid-line (Figures 13, 14).

Alternative Techniques

Creating polygonal models. This model building
technique also can be easily adapted to create
polygonal models. To do so, change the options
when creating contour curves from “3 Cubic” to
“Linear” and the output geometry from “NURBS” to
“Polygons.” Although polygonal models are not as
smooth as NURBS models, they are more flexible
with regards to modifying shape and they can be
exported as .OBJ files without conversion.

Automating knot insertion for complex models.
Optionally, it may be useful to partially automate
knot insertion when creating surfaces that are
more complex than our examples. To do this, sim-
ply create curves as described above and then
automatically insert additional knots within each
span. The new knots will not necessarily lie upon
the template surface, but they can be “snapped” to
the surface as in Figure 9. Although it requires an
extra step, this technique makes it easier to ensure
that multiple complicated curves have the same
number of spans distributed with the same density
along their lengths.

Validation and Repeatability

To evaluate accuracy and repeatability, the
procedure was performed a total of 15 times upon
a neural arch of Acanthostega by three different
operators (JLM, JRH, SEP). JLM had been trained
to use Maya, while JRH and SEP had never used
the program before. The two untrained operators
were instructed in the use of the Maya interface by
JLM and then given a file with the template mesh
and a printout of the instructions contained in the
Materials and Methods section. Each operator per-
formed the model building procedures five times
independently. All completed models were con-

FIGURE 9. Adjusting the placement of the spline knots
on the template surface. Knots were moved along the
surface of the template mesh (on the left; still “Live”) by
dragging in the center of the Move manipulator. The
NURBS surface (right) is updated automatically to reflect
changes in the shapes of the curves.

FIGURE 10. Reconstruction of the medial surface using
reference images. The template mesh is hidden, and
the NURBS shape (grey) created from the lofted curves
has been moved to the left. NURBS curves (blue) are in
the center, and the reference image is on the right
(Coates, 1996, figure 9c). Knots are moved using the
Move tool (yellow/green arrows). The shape of the
NURBS surface is updated dynamically with changes in
the shapes of the curves.
8
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verted to polygons (Modify>Convert>NURBS to
Polygons>Options; Type: “Quads,” Tessellation
method: “Standard fit”) and exported as .OBJ files.
The .OBJ files were converted to .PLY files in
MeshLab. The original .STL file that had been used
as a template also was converted into a .PLY file in
MeshLab. All .PLY files were imported as surfaces
into the program Landmark (version 3.6; free to
download from http://graphics.idav.ucdavis.edu/
research/EvoMorph). 

Linear morphometrics. To determine whether the
dimensions of the original specimen had been pre-
served in the models, four linear measurements
from each surface were taken and analyzed. Six
3D landmark points were placed at corresponding
locations on each model and on the original speci-
men: anterior and posterior tip of neural spine,
anterior and posterior edge of neural arch at base

of neural spine, and anterior and posterior tip of
diapophysis. These points were chosen because
they were easiest to identify consistently on each
surface. Distances between the landmark points
were used to extract four linear measurements:
neural spine width at tip (D1), neural spine width at
base (D2), transverse process width at tip (D3),
and total neural arch height (D4) (Figure 15).  

Shape analysis. In order to capture shape infor-
mation in addition to dimensions, additional 3D
landmark points were semi-automatically placed in
Landmark on the surfaces of the original scan data
and the 15 idealized models. First, the six points on
each surface that had been used in the previous

FIGURE 11. Creating the rib facet. 11.1, the curve form-
ing the edge of the NURBS surface was duplicated
twice and its pivot point was centered; 11.2, one dupli-
cate curve was scaled to 0 and a Loft was performed
between the two curves; 11.3, the resulting NURBS sur-
face was attached to the original surface.

FIGURE 12. Video showing process of creating the rib
facet. 

FIGURE 13. Mirroring and attaching bilaterally sym-
metrical elements. 13.1, neural spine, intercentrum and
pleurocentrum were grouped and duplicated; 13.2, the
group was mirrored across the x-axis (scaled by -1);
13.3, the intercentrum halves were attached at the mid-
line.

FIGURE 14. Video showing process of mirroring and
attaching bilaterally symmetrical elements. 
9
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step to take linear dimensions were identified as
corresponding landmarks between surfaces. Next,
six patches of landmark points were placed on the
surface of the original specimen: two on the neural
spine (one on the medial aspect and one on the
lateral), two on the arch between the zygapophy-
ses, and two on the transverse process. Each
patch consisted of nine landmarks and 16
semilandmarks. The use of patches allowed place-
ment of multiple landmark and semilandmark
points at one time, and it also facilitated the estab-
lishment of correspondence between landmarks on
different models. The patches were semi-automati-
cally applied to the remaining surfaces using the
original mesh as the reference (“atlas”) surface as
described in the Landmark documentation (Figure
15). The six patches were identified as correspond-
ing sets of landmarks. Finally, a total of 66 land-
marks and 96 semilandmarks were exported from
each model. Landmark coordinates for all models
were superimposed using the Generalized Pro-
crustes Method to remove the effects of position,
orientation and scale from the data set. To assess

and visualize shape variation, the aligned data
were then converted into shape variables (i.e., par-
tial warp and uniform component scores) and sub-
jected to a principal components analysis (PCA) in
the geometric morphometrics toolkit Morphologika
(O’Higgins and Jones, 2006). 

Data analysis. Variation in linear measurements
between the idealized models and the original
specimen was visualized using a box and whisker
plot. Because there was only one original speci-
men, calculation of statistical differences between
the idealized models and the original were not pos-
sible; we could only look at inter-operator repeat-
ability. To analyze shape variation between models
built by different operators, a MANOVA was per-
formed using principal component (PC) scores that
accounted for 5% or more of the variation. Explor-
atory and statistical analyses were performed in
the paleontological statistics software package
PAST (version 2.07; folk.uio.no/ohammer/past).

RESULTS

Idealized Model 

The final NURBS model of the complete dor-
sal vertebra of Acanthostega is shown in Figures
16 and 17. The model has 210 knots including con-
tour lines and facets, and it represents our best
estimate of the original 3D morphology of the bone
based on available information.

Validation and Repeatability

Linear measurements. The average difference in
the linear measurements between the models and
the original mesh was 2.0-6.1% (<0.5 mm in all
dimensions) (Table 1). By percentage, the greatest
difference between the models and the original
specimen was transverse process width at tip
(6.09% or 0.22 mm), and the smallest difference
was in total neural arch height (2.00% or 0.44 mm).
The likely reason that transverse process width
was the least accurate is that the tip of the trans-
verse process was difficult to model because the
'knots' were very close together. Between all mod-
els (not including the original specimen), the stan-
dard deviation of linear measurements was 0.21-
0.34 mm (Figure 18).

Shape variation. The Generalized Procrustes
superimposition displays little variation in landmark
positioning (Figure 19). The PCA shows that
groups of models created by the experienced oper-
ator (green diamonds) overlap with those created
by both of the inexperienced operators (blue
squares and pink circles), which also overlap with

FIGURE 15. Landmarks placed for validation. 162
landmarks were used for each model: four two-point
linear measurements (D1, D2, D3, D4) and six patches
(P) - three on the lateral surface and three on the
medial surface - composed of nine landmarks and 16
semi-landmarks each (P1-3 shown; P4-6 are on the
opposite side).
10
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each other (Figure 20). However, the groups of ide-
alized models do not overlap with the original spec-
imen, indicating a departure from the original
shape, an effect probably due to the models’
smoother surfaces. Nonetheless, visualization of
extreme morphologies along PC1 and PC2 shows
little variation between landmark configurations
(Figure 20). PC1, which accounts for 24.3% of the
variation, appears to represent slight anterior-pos-
terior changes in the length of the neural spine and
the sharpness of the transition between the body of
the neural arch and the transverse process. PC2,
which accounts for 14.4% of the variation, appears

to represent slight changes in the width of the nar-
rowest portion of the neural arch (Figure 20). A
MANOVA of the principal components that
accounted for >5% of the variation (PCs 1-7)
showed no significant difference in shape between
models created by different operators (Pillai trace
F value =1.357, p-value: 0.228) supporting the
repeatability of the methodology.

DISCUSSION

Rationale

We chose this approach to the problem of
working with incomplete and low-quality fossil data
in order to maximize simplicity of execution and
minimize the propagation of noise while preserving
gross morphometric measurements and realistic
anatomy. Alternatively, we could have attempted to
retrodeform the element by using a TPS function to
warp the mesh vertices and reconstruct missing
portions using a deformable template (e.g., Zol-
likofer and Ponce de León, 2005). Similarly, if a
complete specimen with sufficient homologous
landmarks were available, we probably could have
achieved good results using a TPS interpolation
function to warp the template specimen (e.g., Zol-
likofer et al., 1998). However, because the verte-
brae of Acanthostega are morphologically distinct
from those of its closest known relatives, and
because we needed only a form consistent with the
preserved bone geometry and not a detailed sur-
face, it was more appropriate in this case to use
generic modeling software to create an idealized
version that was structurally simple enough to ret-
rodeform by adjusting vertices directly. On the

FIGURE 16. Final reconstructions of a dorsal vertebra of Acanthostega. 16.1, left lateral view; 16.2, anterior view;
16.3, posterolateral view. 

FIGURE 17. Animation showing 3D model of a dorsal
vertebra of Acanthostega. 
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other extreme, we could have built a less realistic
model from simple shape primitives based on mea-
surements taken from the fossils (e.g., Stevens,
2002; Souter et al., 2010). In this case a more real-
istic approach was judged preferable both for visu-
alization purposes and to allow us to incorporate
the maximum amount of available data into our
model.

Advantages

The advantages of our landmark-based geo-
metric modeling method are flexibility, control, and
simplicity. There are no requirements for the input
data in terms of file size or mesh quality, although
better scans produce more accurate models. By
drawing contours using landmark points placed
directly on the surface of the mesh, the operator
can control local mesh density and define major
planes, adapting the approach to fit the morphol-
ogy of a particular specimen and the desired
parameters of the model. Multiple meshes can be
integrated, large holes filled, and extraneous struc-
tures ignored, yielding an idealized form. However,
because the model is constructed using the origi-
nal specimen as a template, its creation does not
require artistic expertise, and its dimensions will
closely match the original. Operators who had
never used the program before were trained in the

Maya interface and completed their first simple
model (neural spine of Acanthostega) in approxi-
mately 1 hour (subsequent models took 15-30 min-
utes). We found no statistically significant shape
difference between models created by different
operators, whether or not they were experienced in
using 3D modeling software. In short, this is a reli-
able and repeatable method for building idealized
versions of poorly preserved fossil material. 

Surfaces generated from laser or CT scan-
ners typically require extensive processing to
reduce file size, close holes, and correct errors in
automatic surface generation. Using our method,
processing and reconstruction can be combined
into one step.  In our example, a mesh with

TABLE 1. Linear measurements in millimeters taken from
the original specimen and each model in Landmark. The
measured dimensions were: neural spine width at tip
(D1), neural spine width at base (D2), transverse process
width at tip (D3), and total neural arch height (D4).

D1 D2 D3 D4
Original 8.54 7.17 3.61 22.09

JLM_01 8.08 7.08 3.58 21.30

JLM_02 8.34 7.02 3.56 21.56

JLM_03 8.51 7.12 3.08 21.80

JLM_04 8.67 7.26 3.42 21.31

JLM_05 8.44 7.14 3.47 21.46

SEP_01 8.17 7.93 3.52 21.32

SEP_02 8.02 6.95 3.31 21.94

SEP_03 8.22 6.94 3.22 21.70

SEP_04 7.97 6.95 3.72 21.64

SEP_05 8.27 7.20 3.57 21.44

JRH_01 7.83 7.05 3.49 21.66

JRH_02 7.86 7.08 3.08  22.30

JRH_03 7.95 7.16 3.15 22.40

JRH_04 8.41 7.10 3.65 21.98

JRH_05 8.23  7.16 3.33 21.96

Model average 8.20  7.14 3.41 21.72

Highest value 8.67  7.93 3.72 22.40

Lowest value 7.83 6.94 3.08 21.30
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FIGURE 18. Box and whisker plot showing variation
within four linear measurements taken from 15 neural
arch models: D1 - neural spine width at tip, D2 - neural
spine width at base, D3 - transverse process width at
tip, D4 - total neural arch height.
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134,369 vertices (the neural arch of Acanthostega)
was converted to a NURBS surface with only 44
control points. This reconstruction method allows
the operator to specify important landmarks and
major planes and interactively to adjust the shape
of surfaces between them, as opposed to decima-
tion and re-meshing (e.g., Schroeder et al., 1992;
Alliez et al., 2005), which automatically decreases
vertex counts using a density function. Finally,
because it is constructed from NURBS surfaces,
the shape of the model can be adjusted easily and
interactively to correct minor taphonomic deforma-
tion by moving a small number of vertices (e.g.,
Hutchinson et al., 2005). The result is a simple,
illustrative, and substantially accurate model that
can be used for diverse analytical and visualization
applications.

Limitations

Despite its advantages in terms of flexibility,
the lack of automation in our approach imposes
several important limitations. Although we have
tried to standardize the process as much as possi-
ble, each subsequent model extrapolated from a
single specimen will be slightly different. This effect
may be compounded when models are created by
different operators. However, we investigated the
repeatability of model creation by three different
operators with a predetermined set of landmarks
and plan for the mesh structure and found no sig-
nificant difference between the shapes created by

different operators. Although there were shape dif-
ferences between the model and the original speci-
men, likely due to smoothing of the surface, the
average deviation in terms of linear morphometrics
was minimal. For the purpose of biomechanical
analysis, preserving linear dimensions is particu-
larly important because they affect such biome-
chanical indices as cross sectional area and
lengths of lever arms, while surface detail is less
important.

Similar to other retrodeformation techniques,
idealized geometric reconstruction requires land-
marks to be accurately identified and mapped onto
the scan data. Additionally, our mesh creation
method requires the operator to identify major
planes of the specimen and to divide these into an
equal number of segments by placing points at
geometrically strategic locations. The process is
fairly intuitive, but differences in individual judg-
ment may result in some variation, especially if dif-
ferent operators use different sets of landmarks.

It must be stated that the reconstruction is
intended as an idealized, not a fully realistic, repre-
sentation of anatomy. One can be confident that
morphometric measurements taken from the mod-
els using landmarks which were mapped on the
template mesh and converted to spline knots will
be fairly consistent with those taken from the scan
data. However, the surface patches in between the
knots are geometric interpolations and are not nec-
essarily biologically accurate, and surface texture
will be lost (as reflected in the shape differences
between the original specimen and the idealized
models; Figures 19, 20). Additionally, as with any
other method of fossil reconstruction, the maximal
accuracy of the model also is constrained by the
quality of the scan data, because some of the
noise and warping acquired through taphonomic
deformation and data collection is bound to be per-
petuated in the final product.

Applications

Although we developed landmark-based geo-
metric reconstructions to be used as bone meshes
in 3D biomechanics software, they also could be
used for a wide range of other applications. In geo-
metric morphometrics, the models could be used
as base meshes in cases where an insufficient
number of complete specimens exist or when the
specimens to be analyzed display so much mor-
phological variation that a “consensus” base mesh
is impractical (e.g., Souter et al., 2010). Other
potential applications include the solution of prob-
lems that often arise when working with fossil

FIGURE 19. Generalized Procrustes Superimposition of
landmark points showing variation in landmark position
between models.
13
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material (inspired by problems our team has
faced), such as building “watertight” models for
bone mass and center of mass approximation,
reconstructing broken and warped 3D scans using
photographic records of complete specimens, and
“morphing” to reconstruct missing elements in a
series with morphologies that grade continuously
between known elements.  

Future Directions

We have identified several directions in which
this method could be improved and expanded. The
most important is validation: while we have taken a
step in this direction by comparing our model with
the original scan data, a better validation would
involve the use of multiple specimens from differ-
ent taxa that had been artificially degraded to

resemble fossil data (e.g., Boyd and Motani, 2008).
This would allow direct comparison of the recon-
struction with original undistorted anatomy.

A second potential direction for improvement
is automation. With a little scripting knowledge, it
should be possible to automate several of the
steps in the process, such as creating a surface
from the contour curves and attaching articular fac-
ets. However, the main advantage of using our cur-
rent method is operator control, so automation
should be used sparingly. Another major area for
improvement is accessibility. Our method requires
the use of commercial - though widely available
and relatively inexpensive - proprietary software
with which many paleontologists and evolutionary
biologists may not be familiar. A free, open source
modeling program such as Blender (Blender Foun-
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FIGURE 20. PCA showing shape differences along PC1 and PC2 between neural spine models created by different
operators and the original specimen. Green diamonds represent models created by the experienced operator, blue
square and pink circles the inexperienced operators and the black cross represents the original specimen. Visualiza-
tion of extreme morphologies along PC1 and PC2 shows little variation between landmark configurations.
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dation, www.blender.org) might be used instead by
adjusting the procedures to fit the different user
interface. Such software may be more intuitive to
use than Maya for operators with a background in
programming and computer science and less so
for operators with a graphics and animation back-
ground.
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APPENDIX. 

Procedures used to create models in Autodesk Maya. Conventions used to describe Maya procedures are
as follows: “Bold”: denotes a menu set, “Regular>” denotes a menu bar selection, and “‘Italics’” denotes a
dialog box setting. 

Creating NURBS models in Autodesk Maya
Task Procedure

Divide a bilaterally symmetrical mesh along 
its mid-sagittal plane and remove one half.

Polygons: Edit mesh>Cut Faces tool>Options; “Delete cut faces”).

Mapping landmarks onto the 3D surface
Create a UV map Polygons: Create UVs>Automatic Mapping; right-drag> “Object Mode” to return 

to object mode).

Use the 3D Paint tool to mark landmarks and 
contours on the mesh

Rendering: Texturing>3D Paint Tool>Options
Tool Settings>File Textures>Attribute to paint>Color; File Textures>Assign/Edit 
Textures>”Assign/Edit Textures”
Tool Settings>Flood>Color: “white”; Flood> “Flood Paint”
Tool Settings>Color>Color: “blue”
Adjust brush size (Tool Settings>Brush>Radius [U])

Creating contour curves
Make mesh “Live”: Modify>Make Live

Create NURBS curves using the Edit Points 
Curve Tool

Create>EP Curve Tool>Options; degree setting: “3 Cubic”; knot spacing: “Chord 
length”

Lofting to create NURBS shapes
Select all curves one by one moving 
circumferentially around the vertebral 
element

Toolbar>Select tool; Shift-click. (Note: although any curve may be selected first, it 
is important to select the curves sequentially moving around the surface of the 
template mesh.)

Loft curves to create a NURBS surface (Surfaces: Surfaces>Loft>Options) using the following settings: 
Parameterization (controls how the interpolation is handled and whether the 
surface will be a closed loop): “Chord length”; “Auto reverse”; “Close”; Surface 
degree (the degree of the polynomials used to calculate the surface): “Cubic”; 
Output geometry (type of geometry created): “NURBS”. All other settings were 
left at defaults (Figure 6).

Adjustments and extrapolation of missing surfaces.
Slide knots along the surface of the template 
mesh

Select curve, right-click and drag to select “Edit points”; select Edit point with 
Move tool and click and drag on the center of the Move manipulator (Figure 7).

Adjusted knots without snapping to mesh Same as above, but drag arrows of Move tool rather than center.
Create closed facets

Duplicate edge curve Surfaces: Edit curves> Duplicate surface curves; click to select open edge

Duplicate again Edit>Duplicate

Scale one duplicate to a single point Modify>Center pivot; Attribute editor: “Scale X: 0”, “Scale Y: 0”, “Scale Z: 0”

If necessary, move point to center of the open 
edge

Move tool

Loft new curves Shift-click to select, Surfaces>Loft

Attach facet to NURBS shape First select facet, then Shift-click to select NURBS shape (order is important!); 
Edit NURBS>Attach Surfaces>Options; Attach method: “Blend”; Blend bias: “0,” 
“Insert knot,” Insert parameter: “1.0”) (Figure 9).

Mirroring and attaching
Group all elements Shift-click to select; Edit>Group

Mirror Edit>Duplicate; scale by a factor of -1 in the X direction (Attribute editor: “Scale 
X: -1”, “Scale Y: 1”, “Scale Z: 1”)

Attach halves at mid-line Shift-click to select; Surfaces: Edit NURBS>Attach Surfaces>Options: Attach 
method, “Connect”; Multiple knots, “Remove.” (Figure 10)

Alternative techniques
Create polygonal models Create>EP Curve Tool>Options, degree setting: “Linear”; knot spacing: “Chord 

length”; output geometry: “Polygons”

Partially automate knot insertion Surfaces: Edit Curves>Insert Knots>Options>Insert location: “Between 
selections.” “Multiplicity” setting determines how many knots will be inserted 
within each span
18


	Idealized landmark-based geometric reconstructions of poorly preserved fossil material: a case study of an early tetrapod vertebra
	Julia L. Molnar, Stephanie E. Pierce, Jennifer A. Clack, and John R. Hutchinson
	INTRODUCTION
	Background
	Related Work - 3D Virtual Fossil Reconstruction
	Polygonal Surfaces, Splines, NURBS, and Landmarks

	MATERIALS AND METHODS
	Purpose of Study
	CT Datasets
	Segmentation of CT data
	Creating NURBS Models in Autodesk Maya
	Alternative Techniques
	Validation and Repeatability

	RESULTS
	Idealized Model
	Validation and Repeatability

	DISCUSSION
	Rationale
	Advantages
	Limitations
	Applications
	Future Directions

	ACKNOWLEGMENTS
	REFERENCES



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


